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 Bu modül, mesleki ve teknik eğitim okul/kurumlarında uygulanan Çerçeve 

Öğretim Programlarında yer alan yeterlikleri kazandırmaya yönelik olarak 

öğrencilere rehberlik etmek amacıyla hazırlanmış bireysel öğrenme 
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AÇIKLAMALAR 
MODÜLÜN KODU 213GIM307 

ALAN  Grafik ve Fotoğraf 

DAL/MESLEK Grafik Operatörü 

MODÜLÜN ADI  Tipografik Düzenlemeler 

MODÜLÜN TANIMI  

Yazı karakterlerinden faydalanılarak iki boyutlu yüzey 

üzerinde tipografi uygulamalarının ve öğrenim konularının 

anlatıldığı bir  öğrenme materyalidir. 

SÜRE 40/24 

ÖN KOŞUL 
Temel Tasarım, Temel Desen Dersi, Temel Yazı, Yazı 

Düzenlemeleri, Vektörel Çizim modüllerini almış olmak 

YETERLİK Tipografik düzenlemelerle yüzey oluşturmak 

MODÜLÜN AMACI 

Genel amaç 

Bu modül ile gerekli ortam sağlandığında grafik 

çalışmaları için tipografik elemanları görsel hiyerarşi ve 

tipografik sistemlere uygun olarak mesaja dikkat çekerek 

tipografik düzenlemeler yapabileceksiniz. 

Amaçlar 

1. Bir metni tipografide görsel hiyerarşiye uygun olarak 

yüzey üzerinde düzenlemesini yapabileceksiniz. 

2. Tipografik elemanlarını kullanarak tipografik 

sistemlere göre belirlenen yüzey üzerinde 

düzenlemesini yapabileceksiniz. 

EĞİTİM ÖĞRETİM 

ORTAMLARI VE 

DONANIMLARI 

Ortam: Grafik, atölye ve laboratuvarları, sınıf, işletme, 

kütüphane, ev, bilgi teknolojileri ortamı vb. 

Donanım: Bilgisayar, tarayıcı, yazıcı, çizim masası, ışıklı 

masa, amblem arşivi cdleri, internet, dergi ve mecmualar, 

projeksiyon. 

ÖLÇME VE 

DEĞERLENDİRME 

Modülün içinde yer alan her faaliyetten sonra, verilen 

ölçme araçlarıyla kazandığınız bilgileri ölçerek kendi 

kendinizi değerlendireceksiniz. 

Öğretmen, modül sonunda size ölçme aracı ( test, çoktan 

seçmeli, doğru yanlış vb.) uygulayarak modül 

uygulamaları ile kazandığınız bilgileri ölçerek 

değerlendireceksiniz. 

AÇIKLAMALAR 
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GİRİŞ 
 

 

Sevgili Öğrenci, 

 

Grafik tasarımla uğraşırken yazı ile mutlaka karşılaşırız. Tasarım sırasında 

kullandığımız tipografik elemanların her birinin, iletişimin bir araç olan okunabilirliği ve 

anlaşılabilirliği sağlamaya yönelik olduğu göz önünde bulundurduğumuz zaman, yazı ile 

tasarım kavramının ne kadar önem taşıdığını anlamaya başlarız. 

 

Yazının kullanımı ve işlevi ne olursa olsun diğer tasarım elemanları ile bütünlük 

halinde olmalı ve bir arada geliştirilmelidir. Hangi tasarım ve üretim tekniği kullanılırsa 

kullanılsın tipografinin kurallarını iyi bilmek gerekir. Kuralları iyi bilen bir grafik tasarımcı, 

tasarım süreci içerisinde hedefe ulaşmak için bu kuralları daha iyi bozabilir, değiştirebilir, 

oynayabilir ve onlara yeni anlamlar verebilir. 

 

Hazırlanan bu modül de tipografide görsel hiyerarşi, tipografik sistemleri kullanarak 

vektörel programda düzenleme çalışmalarını içermektedir. Modül sonunda öğrendiğiniz bilgi 

ve becerileri sanat ile ilgili tüm alanlarda kullanabilir ve hatasız bir biçimde tipografi 

tekniğinde uygulayabilirsiniz. 

 

  

GİRİŞ 
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ÖĞRENME FAALİYETİ–1 
 

 

Bu faaliyette verilecek bilgiler doğrultusunda, uygun ortam sağlandığında bir metni 

tipografide görsel hiyerarşiye uygun olarak yüzey üzerinde düzenlemesini yapabileceksiniz. 

 

 

 

 

 Dergi ve gazetelerde uygulanan tipografik çalışmaları inceleyiniz. 

 İnternetten tipografi sitelerinden tipografik çalışmalar araştırınız. 

 Bulduğunuz çalışmaları dosyalayınız. 

 Bu çalışmaları arkadaşlarınızla inceleyiniz. 

 

1. TİPOGRAFİDE GÖRSEL HİYERARŞİ 
 

Tipografi tasarımında amaç mesajın okuyucu tarafından doğru anlaşılması ve dikkat 

çekmesidir. Mesajda kullanılan metinleri farklı varyasyonlarla zenginleştirme seçenekleri 

kullanılabilir. Mesajda kullanılan metinlerin seçiminde de kullanılacak alan dikkate alınarak 

seçimin yapılması önemlidir. 

 

1.1. Çizginin kullanımı 
 

Çizgi görsel olarak bir düzenleme ve mesajı vurgulama aracı olarak kullanılır. Aynı 

kalınlıkta ve uzunluktaki çizgiler düzenleme elemanı olarak işlev görür. Çizgi kalınlığı ve 

uzunlukları değiştikçe düzenlemeye ritm kazandırdığı gibi mesajın okunmasında gözün 

takibini hızlandırır. Çizginin farklı kalınlıkta ve uzunlukta kullanılması verilmek istenen 

mesajda öncelikle algılanması gereken noktalara dikkati çekerek bir hiyaraşi oluşturma 

özelliği de vardır. 

 

 

Şekil 1.1: Mesajda çizginin kullanımı 

ÖĞRENME FAALİYETİ–1 
 

AMAÇ 

ARAŞTIRMA 
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Vektörel programda çizgiyi kullanmak için sol taraftaki tool kısmından line aracı 

seçilir. Yatayda veya dikeyde düz çizgi çizmek için line aracını seçtikten sonra mausun sol 

tarafına sayfa üzerinde basılır ve parmak çekilmeden shift tuşunada aynı anda basılı iken 

istenen uzunlukta  shift tuşuna basılı tutulur ve bırakılır. Çizgi kalınlığını üst taraftaki stroke 

penceresinde istenen kalınlıkta punto ölçüsü girilir. Çizgi rengini değiştirmek içinse sol 

taraftaki araçlar kutusunda veya üst control panelinden istenen renk seçilir.  

 

 

Şekil 1. 2: Vektörel programda line aracını kullanma. 

1.2. Espas  
 

Mesajda harf ve kelime aralıklarının değişimi görsel olarak farklı dokular oluşturur. 

Harf aralıklarında mesafe artırıldığı zaman karışıklığı önlemek için kelime aralıklarınında 

artırılması gerekir. Bu aralıkları ayarlarken mesajın okunması dikkate alınmalıdır. 

 

 

Şekil 1.3: Mesajda espas farklılıkları 

Vektörel çizim programında metinde kelime ve harf aralıkları ve de font değişiklikleri 

aşağıda gösterilen character panelinde belirtilen yerlere değerler girilerek yapılır. 
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 Harfler arası boşluk: Bu seçeneği, imleci iki harfin arasına yerleştirerek 

ayarlarsınız. Harfleri birbirinden ayırmak için yukarı oka tıklayarak veya bir 

değer girerek bu miktarı artırabilirsiniz; harflerin arasındaki boşluğu azaltmak 

için daha düşük bir değer, hatta negatif bir sayı girebilir veya aşağı oka 

tıklarsınız.  

 

 İki harf arası boşluk: Tracking seçeneğini, birden fazla harf seçip yukarı veya 

aşağı oka tıklayarak veya pozitif ya da negatif bir değer girerek bunların 

arasındaki boşluğu artırmak veya azaltmak için kullanırsınız.  

 

 Satır arası boşluk: Bu kutuyu kullanarak metin satırlarının arasında ne kadar 

boşluk olacağını belirlersiniz. Illustratorda yazı boyutu toplam satır aralığına 

dâhil edilerek profesyonel bir dizgicilik yöntemi kullanılmaktadır. Diğer bir 

deyişle, eğer kullandığınız karakter boyutu 12 pt ise ve metninizi çift aralıklı 

hale getirmek istiyorsanız satır aralığı (değerini) 24 pts yaparsınız.  

 

 

Şekil 1.4: Vektörel programda harf ve satır aralıklarını ayarlama. 

1.3. Cümle bölme 
 

Verilmek istenen mesaj metnini ilgi çekici hale getirmek için, kullanılan sayfa 

alanınıda dikkate alarak; 

 

Öncelikle cümle bölünmesinde okuyucunun mesajı okurken anlam bütünlüğünün 

bozulmamasına dikkat edilmelidir. Örneğin aşağıdaki cümleden bir örnek vererek açıklamak 

gerekirse,  

 

Görsel bir dil tipografik tasarım şeklinde cümleyi bölmek yanlış olacaktır. 



 

 6 

Cümle bölünmelerinde bölüntü yapılacak yerler mesajın okunurken akıcılığını dikkate 

alarak yapılmalıdır. 

 

 

Şekil 1.5: Mesajda cümle bölme 

Bölüntü yapılan cümlenin satır aralıklarını ayarlarken de yine mesajın rahat okunması 

dikkate alınmalıdır. 

 

 

Şekil 1.6: Mesajda cümle bölme ve satır aralıkları 

1.4. Dairenin kullanımı 
 

Daire kompozisyonda joker eleman olarak kullanılır, yani kompozsiyonda herhangi 

bir yerde yer alabilir. Daire tasarımcı için yardımcı görsel bir araçtır;  

 

 Kompozisyonda dengeyi sağlamak, vurguyu artırmak, kompozisyona 

dinamiklik kazandırmak için kullanılır.  

 Bazende kompozisyonun başlangıç ve bitiş noktalarına işaret etmek için de 

kullanılır.  

 İki ayrı cümle arasında bağlantıyı sağlamak için de kullanılır. 
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Şekil 1.7: Mesajda dairenin kullanım alanları 

1.5. Tonlama 
 

Tonlama verilmek istenen mesajda öncelikle algılanması gereken noktalara dikkati 

çekerek bir hiyararşi oluşturur. Göz beyaz yüzeyde büyük koyu alanları daha çabuk algılar 

veya tam tersi koyu zemin üzerinde büyük açık alanları daha çabuk algılar.  

 

Bazende verilmek istenen mesajda ön plana çıkarılmak istenen yerlerde kelime veya 

harflerde tonlama yapılabilir. 
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Şekil 1.8: Mesajda tonlama 

Vektörel çizim programında yazılmış metin üzerinde kelime veya harf renginde 

değişiklik yapmak için araç kutusundan T aracı seçilir. İmleç harfin yanına mausla sol tuşa 

basılı iken sola doğru çekilir, aşağıdaki resimde de görüldüğü gibi seçili haldeki harf arka 

planı siyah renk alır. Bu halde iken harfin rengi araç kutusundaki renk kutusundan istenen 

renk ile boyanır. 

 

 

Şekil 1.9: Vektörel programda metinde tonlama.  
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UGULAMA FAALİYETİ 
Aşağıdaki işlemleri tamamladığınızda bir metni yüzey üzerinde vektörel çizim 

programında düzenlemesini yapmış olacaksınız. 

 

Kullanılacak araç ve gereçler 

 Bilgisayar 

 Vektörel çizim programı 

 Görseller 

 

İşlem Basamakları Öneriler 

 Araç gereçleri hazırlamak 
 Araç gereçlerinizin eksiksiz olmasına özen 

gösteriniz. 

 Verilen cümleyi aşağıdaki sıralamaya 

göre sayfada düzenlemek 

 Cümleyi anlamaya çalışınız. Düzenleme 

yaparken anlamınının bozulmamasına 

dikkat ediniz. 

 çizgi 

 Çizgilerin anlamı bozmamasına dikkat 

ediniz. 

 Gereksiz çizgi kullanmayın. 

 espas 

 Harflerin okunurluğuna dikkat ediniz.  

 Espas yaparken harflerin yapısına dikkat 

ediniz. 

 anlamına göre cümleyi bölme  Okunaklığa önem veriniz. 

 cümlede öncelikle algılanması gerekli 

yerde dairenin kullanımı 

 Cümleleri bölerken akıcılığı bozmamasına 

dikkat ediniz. 

 cümlede vurgulamayı tonlama ile 

yapma 

 Vurgu yapacağınız cümle üzerinde 

tonlama yapınız. 

 

UYGULAMA FAALİYETİ 
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ÖLÇME VE DEĞERLENDİRME 

UYGULAMALI TEST 
 

Bir metni kullanarak yüzey üzerinde kompozisyon kurallarını dikkate alarak tipografik 

düzenlemesini yapınız. Çalışmanızı aşağıdaki değerlendirme ölçeğine göre değerlendiriniz. 

 

Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız becerileri Evet 

ve Hayır kutucuklarına (X) işareti koyarak kontrol ediniz. 

 

Değerlendirme Ölçütleri Evet Hayır 
1. Araçları hazırladınız mı?   

2. Eskize uygun kâğıt seçtiniz mi?   

3. Eskiz çizdiniz mi?   

4. Eskizde detaylara yer verdiniz mi?   

5. Eskizi renklendirmek   

6. Zamanı verimli kullanmaya dikkat ettiniz mi?   

7. Çalışmanızı verilen sürede tamamlayabildiniz mi?   

 

 

 

DEĞERLENDİRME 
 

Uygulama faaliyetinde kazandığınız davranışlarda işaretlediğiniz evetler kazandığınız 

becerileri ortaya koyuyor. Hayırlarınız için ilgili faaliyetleri tekrarlayınız 

 

Tamamı evet ise diğer öğrenme faaliyetine geçiniz. 

ÖLÇME VE DEĞERLENDİRME 

DEĞERLENDİRME 
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ÖĞRENME FAALİYETİ–2 
 

 

Bu faaliyette verilecek bilgiler doğrultusunda, uygun ortam sağlandığında, tipografik 

elemanlarını kullanarak tipografik sistemlere göre belirlenen yüzey üzerinde düzenlemesini 

yapabileceksiniz. 

 

 

 Çevrenizde tipografi ile hazırlanmış materyallerden görsel araştırmalar yapınız. 

 Tipografi ile ilgili görsel kaynaklardan araştırma yapınız. 

2. TİPOGRAFİK SİSTEMLER 
 

Tipografik sistemler sayfada metin hizalamak için kullanılan yöntemleri içerir. Bunlar 

sayfada kullanılan metinleri koordine ederek,  görüneni daha ilgi çekici hale getirmeye 

yardımcı olur. 

 

 

 

2.1. Aks Sistemi 
 

Aks düzenlemesi en basit sistemdir. Tüm elemanlar tek bir eksenin solunda veya 

sağında düzenlenir. Düzenleme yapılacak simetrik veya asimetrik kompozisyonda aks 

sayfanın her hangi bir yerinde olabilir. 

 

 

Şekil 2.1: Aks sistemi örnekleri.  

 

AMAÇ 

ARAŞTIRMA

A 

ÖĞRENME FAALİYETİ–2 
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Resim 2.1: Aks sistemine örnek afiş çalışmaları.  

Vektörel programda sayfa cetvellerinin görünür olması işimizi kolaylaştıracaktır. 

Cetvellerden ekrana alınan rehber çizgileri baskıda görünmeyen sanal çizgilerdir. Bu 
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çizgileri fare yardımı ile cetvellerden ekrana alabiliriz. İster yatay, ister dikey ya da çapraz 

olarak çizgileri kullanabiliriz. 

 

 

Şekil 2.2: Rules açılandırma.  

2.2. Grid (Izgara) Sistemi 
 

Dikey ve yatay bölünmelerden oluşan bir sistemdir. Amaç dikey ve yatay bölümler 

arasında görsel bir ilişki oluşturmaktır. 

 

 

Şekil 2.3: Grid sistem.  
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Resim 2.2: Grid sisteme örnek çalışma 

 

Resim 2.3: Grid sisteme göre tasarlanmış web sayfası  
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Resim 2.4: Grid sisteme örnek dergi sayfası 

2.3. Koram 
 

Bütün elemanlar bir merkezden dairesel olarak genişleyerek düzenlenir. 

 

 

Şekil 2.4: Korama örnek çalışmalar 
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 Bir yolun üzerinde metin oluşturmak 

 

Belirli bir metni bir yolun üzerine yerleştirmek için şu adımları uygulayın: 

 

Kalem, çizgi parçası veya kurşun kalem aracını kullanarak bir yol oluşturun. Yazım 

aracını seçin ve imleci yolun üzerine getirin. 

 

Üzerinde kavisli bir çizgi bulunan bir I çubuğu belirdiğinde (bu imleç, metnin yolu 

izleyeceğini gösterir) tıklayın. 

 

Yazmaya başlayın metin yolu takip edecektir. Metnin yolu düzgün bir şekilde takip 

edemediği noktalarda konumunu yeniden ayarlamak için Window > Type > Paragraph 

komutunu seçin ve paragraf panelini kullanarak hizalama ayarını değiştirin. 

 

Alternatif olarak, metni serbestçe taşımak için seçim aracına geçin ve I çubuğunu 

sürükleyin. 

 

Tıklayıp I çubuğunu yolun altına veya üstüne doğru sürükleyerek metni yolun diğer 

tarafında yer alacak şekilde çevirebilirsiniz. 

 

 

Şekil 2.5: Metni yola sarmak.  
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Resim 2.5: Genişlemeli sisteme örnek afiş çalışmaları.  

2.4. Modüler Sistem 
 

Metinler standart birimler içinde tasarım kurallarını dikkate alarak yüzeyde 

düzenlenir. 
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Şekil 2.6: Modüler sistem.  

     

Resim 2.6: Modüler sisteme örnek afiş çalışmaları. 

 Metni şekillerin içinde akıtmak 

 

Metinleri kapalı şekillerin içinde akıtarak farklı şekillere ve boyutlara sahip özel metin 

sütunları oluşturun. Bu teknik dikdörtgenler, daireler, yıldızlar veya diğer her türlü kapalı 

şekille kullanılabilir ve böylece yaratıcı metin alanları oluşturabilirsiniz. 

 

İstediğiniz boyutta herhangi bir şekil oluşturun. Sayfanın başka bir yerinde başka bir 

şekil oluşturun (herhangi bir şekil olabilir).  
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Seçim aracını kullanarak şekillerden birini seçin ve shift tuşunu basılı tutarak diğer 

şekle tıklayın, böylece iki şekil de etkin duruma gelecektir.  

 

Type > Theareded Text> Create komutunu seçin.  

 

Yukarıdaki şekildeki gibi, akıtılan metnin yönünü gösteren bir akış çizgisi belirecektir.  

 

Yazım aracını seçin, akıtma işlemini başlatmak için şeklin üst kısmına tıklayın ve 

yazmaya başlayın.  

 

Metin bir şekilden diğerine akmaya başlayıncaya kadar yazmaya devam edin. 

 

     

Resim 2.7: Modüler sisteme örnek afiş çalışmaları. 

Eğer metnin artık akmasını istemiyorsanız, Type > Theareded Text > Release 

Selection komutunu seçin; bu komut, metin şekillerindeki bütün akıtma özelliklerini iptal 

eder. Bir ya da daha fazla şeklin (tüm şekillerin değil) akıtma özelliğini iptal etmek için ilgili 

şekli ya da şekilleri seçin ve ardından Type > Theareded Text > Remove Thearding 

komutunu seçin.  
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Şekil 2.7: Metinleri alan içlerine akıtmak. 

 İkiden fazla nesneleri eşit aralıklı yerleştirmek; 

 

Nesneleri çizdikten sonra hepsi seçilir ve align penceresinden horizontal distribute 

space komutu uygulanır. 

 

 

Şekil 2.8: Nesneleri eşit aralıklı yerleştirmek. 
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2.5. Layer (Katman) Sistemi 
 

Metinler katmanlar şeklinde ve kaydırılarak düzenlenir. 

 

 

Şekil 2.9: Geçişli sistem. 

 

Resim 2.8: Geçişli sisteme örnek afiş çalışması. 
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2.6. Rastlantısal Sistem 
 

Elemanlar arasında belirli bir düzen ya da ilişki yoktur. Rastlantısal sistemde 

kullanılan elemanlar kendi aralarında yönde, yöntemde, kuralda belirli bir amaç olmadan 

düzenlenir. 

 

 

Şekil 2.10: Rastlantısal sistem.  

 

Resim 2.9: Rastlantısal sisteme örnek afiş çalışmaları.  



 

 23 

UYGULAMA FAALİYETİ 
Aşağıdaki işlemleri tamamladığınızda vektörel programda aks sistemine uygun 

tipografik yüzey düzenlemesi yapabileceksiniz. 

 

Kullanılacak araç ve gereçler 

 Bilgisayar 

 Vektörel çizim programı 

 Görseller 

 

İşlem Basamakları Öneriler 

  Kullanılacak araç ve gereçleri temin 

ediniz. 

 Araç ve gereçleri eksiksiz temin etmeye 

özen gösteriniz. 

 Vektörel programda istenen ölçüde 

yeni bir sayfa açınız. 
 Ölçülere dikkat ediniz. 

 Metinde kullanılacak harf karakterini 

seçiniz. 

 Hangi konu ile ilgili ise konuya uyacak 

karakter seçmeye dikkat çekiniz. 

 Okunaklığa önem veriniz. 

 Hangi aks sistemine uygun düzenleme 

yapacağınıza karar veriniz. 

 Kompozisyon ilkelerini dikkate alınız. 

 Açılı akslar için transform aracından 

faydalanınız. 

 Sayfada aksları cetvellerle (View-

Rules) belirleyiniz 

 Açılı akslar için transform aracından 

faydalanınız. 

 Metin alanlarını oluşturunuz. 
 Cümleleri bölerken akıcılığı bozmamasına 

dikkat ediniz. 

 Metinleri düzgün bir şekilde 

yerleştiniz. 

 Metinleri açılı olarak yerleştirecekseniz 

transformdan açısını veriniz.. 

 Metnin düzenleme işlemini yaptıktan 

sonra metinde ilgi çekiciliği vurguyu 

ve akıcılığı kazandırmak için çizgi, 

daire ve tonlama seçeneklerini 

kullanınız. 

 Bilgi konularını tekrar gözden geçiriniz. 

 Çalışmanızın dijital çıktısını alıp 

arkadaşlarınızla eleştirisini yapınız. 

 Çalışmanızı kullandığınız programın 

dosya formatında kaydediniz. 

 Dijital çıktısını alınız. 

 
 

UYGULAMA FAALİYETİ 
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ÖLÇME VE DEĞERLENDİRME 
UYGULAMALI TEST 

 

Vektörel programda tipografik sistemlerden birine uygun düzenleme yapınız ve 

çalışmanızı aşağıdaki değerlendirme ölçeğine göre değerlendiriniz. 

 

Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız becerileri evet 

ve hayır kutucuklarına (X) işareti koyarak kontrol ediniz. 

 

Değerlendirme Ölçütleri Evet Hayır 

1. Tarama işlemlerini yaptınız mı?   

2. Vektörel programa çizimi eklediniz mi?   

3. Vektörel programda çizim yapıp kompozisyon oluşturdunuz 

mu? 
  

4. Vektörel programda çizimleri renklendirdiniz mi?   

5. Yazıları resim formatına çevirdiniz mi?   

6. Çalışmaları uygun formatta kaydettiniz mi?   

7. Yazıcıdan çıktı aldınız mı?   

8. Paspartu hazırladınız mı?   

9. Çalışmaları kaydettiniz mi?   

10. Sunum dosyası hazırladınız mı?   

 

 

 

DEĞERLENDİRME 
 

Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. 

Kendinizi yeterli görmüyorsanız öğrenme faaliyetini tekrar ediniz. Bütün cevaplarınız 

“Evet” ise modül değerlendirmeye geçiniz. 

ÖLÇME VE DEĞERLENDİRME 
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MODÜL DEĞERLENDİRME 
Modül sonunda kazandığınız yeterliği aşağıdaki uygulamayı yaparak değerlendiriniz. 

 

Seçtiğiniz bir metni ve nesneleri birlikte kullanarak vektörel programda tipografik 

düzenleme yapınız. 

 

Değerlendirme Ölçütleri Evet Hayır 
1. Araç ve gereçleri temin ettiniz mi?   

2. Eskize uygun kağıt seçtiniz mi?   

3. Eskiz çizdiniz mi?   

4. Eskizi renklendirdiniz mi?   

5. Tarama işlemlerini yaptınız mı?   

6. Vektörel programda yeni bir sayfa açtınız mı?    

7. Vektörel programa çizimi eklediniz mi?   

8. Vektörel programda çizim yapıp kompozisyon hazırladınız 

mı? 
  

9. Çizimleri renklendirdiniz mi?   

10. Metni belirlediniz mi?   

11. Metinde kullanılacak harf karakterini konuya uygun seçtiniz 

mi? 
  

12. Hangi tipografik sisteme uygun düzenleme yapacağınızı 

belirlediniz mi? 
  

13. Espas ayarlarını yaptınız mı?   

14. Yazıları resim formatına çevirdiniz mi?   

15. Cümle bölüntüsünü doğru yaptınız mı?   

16. Düzenlemede çizgi unsurunu kullandınız mı?   

17. Düzenlemede daire unsurunu kullandınız mı?   

18. Düzenlemede tonlama ve renk unsurunu kullandınız mı?   

19. Çalışmayı uygun formatta kaydettiniz mi?   

20. Çalışmanızın dijital çıktısını alıp eleştirisini yaptınız mı?   

21. Zamanı verimli kullanmaya dikkat ettiniz mi?   

22. Çalışmanızdan memnun kaldınız mı?   

 

 

 

DEĞERLENDİRME 
 

Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. 

Kendinizi yeterli görmüyorsanız öğrenme faaliyetini tekrar ediniz. Bütün cevaplarınız 

“Evet” ise bir sonraki modüle geçiniz. 

MODÜL DEĞERLENDİRME 
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